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Introduction 
The Department of Planning and Environment publishes map data in a variety of web 
service formats that may be viewed through standard internet browsers, dedicated map 
viewers such as SEED (Sharing and Enabling Environmental Data), integrated into 
specialised geographic information system (GIS) software, or programmed directly into 
mobile or business applications. 
This document provides advice to novice and technical users on how to use and get the 
most out of map data services and web map browsers: 

Part 1 Quick Start Guide 
Simple steps to get you started viewing maps in SEED 

Part 2 Technical Guide 
Detailed options and instructions for browser and GIS users. 

SEED is a data portal that allows users to search for environmental data and display it in a 
built-in map viewer. 
The map data services offered by the Department of Planning and Environment are 
generated using ArcGIS REST Service technology and include Open Geospatial Compliant 
(OGC) web services including Web Map Service (WMS), Web Feature Service (WFS), and 
Keyhole Markup Language (KML). 

Part 1: Quick Start Guide 
Get started by viewing a WMS web service in your internet browser following these simple 
steps. 

Step 1 Locate a Web Map Service in SEED 
While there are any number of data catalogues out there, the following instructions are 
based on SEED: 

• use a keyword(s) search to quickly locate the data, e.g. enter ‘SVTM’ to find State 
Vegetation Type Map (SVTM) products 

• select Show on SEED Map to display the data directly in the SEED map viewer, or 
• select View Dataset to access web service ‘resources’ (see Figure 1). 
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Figure 1 Selecting ‘Show on SEED Map’ or ‘View Dataset’ 

Step 2 Launch map in a browser 
ArcGIS Online Map Viewer is an alternative to the SEED Map and is also suitable for users 
without GIS Software: 

• click on ‘View Dataset>’, scroll down to ‘External Links’ and expand 
• click on ‘ArcGIS REST SERVICE’ under ‘External Links’ (see Figure 2) 

 
Figure 2 ArcGIS REST Service 

• click on the URL for the REST Service 

 
Figure 3 Rest Service URL 

• click on ‘Acknowledge and Proceed to ARCGIS REST SERVICE’ 
• click on ‘ArcGIS Online Map Viewer’. 
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Figure 4 Opening ArcGIS Online Map Viewer 
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Step 3 Progress to the next level 
When you are ready to take it to the next level consider these options: 

1. Internet browser users: 
Explore the extended functionality of REST Services, ArcGIS Online Map Viewer.  
Note that you may need to use Google Chrome or FireFox for superior performance. 

2. GIS users: 
ArcMap is recommended for users with ArcGIS. It has options that ‘automatically’ connect to 
and open the vegetation map. It enables users to spatially inquire (i.e. click on a point to 
reveal attributes) on the WMS data. 
Alternatively, users can manually connect to the service to view the map via a series of steps 
based on the WMS, see Section 2.6 below. 
ArcGIS Online Map Viewer and ArcGIS Earth are free GIS viewing software, available 
online. Both viewers have restricted functionality and generally only permit map display and 
zooming between scales. As the internet browser option ArcGIS Online Map Viewer 
provides many of these options, including the ability to combine multiple map data services, 
and to search on properties, ArcGIS Online Map Viewer is recommended for users without 
GIS software. 
QGIS is a free and open source GIS system and is a direct alternative to ArcGIS/ArcMap 
software for GIS users. While detailed instructions on how to use QGIS are beyond the 
scope of this guide, information is provided on how to connect to WMS or WFS in QGIS. 
Table 1 summarises the various browsers and GIS applications, and their capabilities. 

Table 1 Browsers and software for WMS 

Browser/software Zoom 
(in/out) 

Layer 
legend 

Modify 
transparency 

Add 
data 

Display 
attributes 

Spatial 
query 

Save 
map 

ArcGIS JavaScript ✓       

ArcGIS Online Map ✓ ✓ ✓ ✓ ✓  ✓ 

ArcGIS Earth ✓  ✓ ✓    

Google Earth ✓  ✓ ✓    

ArcGIS Pro ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

ArcMap ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

QGIS ✓ ✓ ✓ ✓ ✓ ✓ ✓ 

WMS is a standard protocol for georeferenced images served over the internet. The images 
are sourced from a GIS server. The images may be constructed from several GIS layers. 
The image format restricts the user to map display and basic queries, depending on the 
functionality of the browser or application. WMS is commonly used to maximise performance 
over the internet. 
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Part 2: Technical Guide 

2.1 SEED 
The following is a brief introduction to using SEED for displaying and working with BioNet 
map data. 
As described in Part 1, enter a search term in the search box (see Figure 5). 

 
Figure 5 Keyword search box in SEED 

Select Show on SEED Map to view the dataset in the built-in map (see Figure 6). 

 
Figure 6 ‘Show on SEED Map’ button in SEED 
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Click ok for any notifications. The map will display. Under Legend, select the Panel Actions 
Menu, then Show Layer List (see Figure 7). 

 
Figure 7 Selecting ‘Show Layer List’ 

The Layer List now shows the WMS for the BioNet SVTM map, and the layers used to 
construct it. Each layer is built from a separate data (map) source. In Figure 8, the NSW 
Plant Community Type 5 m raster is displayed based on the zoom scale. 

 
Figure 8 SVTM layers list 
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Zoom in to progressively display the other layers, or select the arrow next to a layer, then 
zoom to visible scale. In the examples below, the zoom scale will be set so that plant 
community type (PCT) label points are visible (Figure 9); however, first ensure the map is 
centred in the viewer, or that you have zoomed to the full extent of the map. This will help 
prevent zooming in to the desired scale, but in an area away from the map data. 

 

 
Figure 9 Selecting ‘Zoom to visible scale’ 
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Figure 10 shows PCTs and labels. Click anywhere on the map to reveal the attributes for 
that point. 

 
Figure 10 PCTs, labels and attributes 

Other map data may be added to the view by selecting I want to… then Layer Catalog (or 
Search for Datasets on Map) (see Figure 11). 

 
Figure 11 Adding a layer 
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If, for instance, you would like to determine what PCTs are on a property, you can select Lot 
from the list of available layers (see Figure 12). (Note the nested structure that must be 
progressively opened to reach the Lot checkbox.) Click OK. 

 
Figure 12 Selecting ‘Lot’ from ‘NSW Cadastre’ 

After the layer is added to the viewer, you can click on the map to reveal the attributes of the 
map layers. In Figure 13, the Lot number is shown. 

 
Figure 13 Attributes for ‘Lot’ 
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To toggle between layer attributes, select the drop-down list beside Lot. Select the name of 
the PCT to show the information about it (see Figure 14). 

 
Figure 14 Toggling between map layers 

Click on Need help? to discover more about what you can do with SEED. 
There are numerous ways to find data in SEED. The ‘Finding data in SEED’ webpage 
provides more detailed search options along with a video link to explain how to find data. 
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2.2 Internet browser using ArcGIS JavaScript 
This is the most basic of viewers that is restricted to map display and zoom/pan functionality. 
First, you may need to ensure that JavaScript is enabled in your browser and that the 
security settings are not blocking display. The ‘Enable JavaScript’ webpage has instructions 
for how to do this in various browsers. 
By clicking on the JavaScript option, the map should display in a new browser window. In the 
example in Figure 15, the map will display to the full data extent, showing NSW extant PCTs. 

 
Figure 15 ArcGIS JavaScript 

By clicking on the zoom arrow, the symbology will progressively change to indicate NSW 
formation, (Keith) classes, then PCTs and labels appear. 
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2.3 Internet browser using ArcGIS Online Map Viewer 
ArcGIS Online Map Viewer (from ArcGIS.com) provides users with a wide variety of basic 
functionality; for example, you can change the base map (satellite, topographic), measure, 
and view the map legend (and labels). You can also search for and add layers, as well as 
search for properties. 

 
Figure 16 Opening ArcGIS Online Map Viewer 

After clicking on the ‘ArcGIS Online Map Viewer’ link as shown in Figure 16, a new browser 
window opens to show the full extent of the map (see Figure 17). 

 
Figure 17 ArcGIS Online Map Viewer 
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Click on the expansion arrow beside SVTM NSW Extant PCT to see the layer list 
(Figure 18). 

 
Figure 18 Expanding the layer list 

By zooming in, the data layers that make up the WMS are displayed at different zoom levels. 
You can see the individual map layers by clicking on the arrow symbol next to the map in the 
‘Contents’ window (see Figure 19). 

 
Figure 19 Example of WMS in the ‘Contents’ window 

Inactive layers are greyed out based on the zoom level in map view. Clicking on the 
checkbox will toggle a layer’s visibility on/off. 
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As you zoom in, inactive layers are progressively displayed and change to active status in 
the layer list (see Figure 20). 

 
Figure 20 Active (displayed) layers in the ‘Contents’ window 

Under each layer are options that permit legend display, table display (vector data), and 
vector data query via a filter (see Figure 21). 

 
Figure 21 Layer options 
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Note that for vector data, if there are many features the table display option (see Figure 22) 
may take some time to display or may not display at all. 

 
Figure 22 Attribute table option 

Use the filter option to search and display (within the table) data values (see Figure 23). 

 
Figure 23 Filter option 

The following example shows how a filter turns other records on or off. Figure 24 shows 
PCTs in an area before a filter is applied. 

 
Figure 24 Map display with all records showing 
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The example in Figure 25, Figure 26 and Figure 27 shows a query based on label records 
with a PCT ID of 3614 (i.e. PCT number 3614). 

 
Figure 25 Selecting ‘APPLY FILTER’ to complete the query 

The results of this example are shown in Figure 26. 

 
Figure 26 Query results 
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By selecting a PCT value of 3614 and applying the filter, the other PCTs are no longer 
displayed (see Figure 27). 

 
Figure 27 Map display after query filter has been applied 

If you click on a table record, you can then zoom to the corresponding polygon on the map. 
The example in Figure 28 shows a record being selected. 

 
Figure 28 Selecting a table record 

Click on the Options pull-down menu and choose Center on Selection (see Figure 29). 

 
Figure 29 Choosing ‘Center on Selection’ in the ‘Options’ pull-down menu 
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The selected record is now shown on the map (see Figure 30). 

 
Figure 30 Display zoomed in on the selected record 

To search for and add new layers, click on Modify Map at the top-right of the browser 
window (see Figure 31). 

 
Figure 31 ‘Modify Map’ button 

This will generate an Add button at the top-left of the window (see Figure 32). 

 
Figure 32 Selecting the ‘Add’ button for more data options 
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The following example demonstrates how to search for and retrieve the NSW cadastre layer. 
First, select Search for Layers from the Add pull-down menu (see Figure 33). 

 
Figure 33 Selecting ‘Search for Layers’ from the ‘Add’ pull-down menu 

Enter the details as shown in Figure 34 then click on the filter button to open the Filter 
window (arrow on left). Now turn on ‘Only show content within map area’ (arrow on right) to 
restrict the search to the state of NSW. 

 
Figure 34 Example of a data search for the NSW cadastre layer 
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This will generate a list of available layers. Select a layer of interest by clicking on the plus 
symbol (see Figure 35). 

 
Figure 35 Results of the data search 

Click on the back arrow (see Figure 36). 

 
Figure 36 Clicking the back arrow 

The cadastre layer should now be visible in the Contents pane and the map display (see 
Figure 37). 

 
Figure 37 Example of a layer (NSW Cadastre) added to the ‘Contents’ pane 
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Building on the previous example where a cadastre layer was added, now enter an address 
in the search box near the top-right of the browser window and click on the magnifying glass. 
The map will centre on the chosen property and provide a box with the search result (see 
Figure 38). 

 
Figure 38 Searching for a property by entering its address 

By using the cadastre boundary, you now have an indication of what vegetation types exist 
on the property. In this example, there are 2 PCTs – PCT IDs 1281 and 1776. 
Choosing to Sign In using the button at the top-right of the screen (see Figure 39) provides 
additional functionality, such as the ability to save your map. 

 
Figure 39 Clicking on the ‘Sign In’ button 

Once signed in, you are presented with the option of saving your map (see Figure 40). 

 
Figure 40 Saving the map 

If you decide to save your map, you need to fill in the form, ensuring that an appropriate tag 
(e.g. ‘vegetation’) is included. 
By saving your map you can edit it later. You may also share it with others. 
Rather than searching for and adding a WMS from the map viewer, an alternative is to 
navigate to the ArcGIS Online Map website and add the WMS URL to the viewer from there. 
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First, copy the WMS URL from ArcGIS REST Services. Note that in the example in 
Figure 41, WFS is not available as this is a raster-based service. 

 
Figure 41 Connecting to WMS from the ArcGIS REST Services Directory 

Select and copy the URL (see Figure 42). 

 
Figure 42 URL of WMS 

Select Modify Map to activate the Add button, then choose Add Layer from Web from the 
pull-down menu (see Figure 43). 

 
Figure 43 Selecting ‘Add Layer from Web’ 

In response to ‘What type of data are you referencing?’ select A WMS OGC Web Service 
(see Figure 44) (OGC = Open Geospatial Consortium). 

 
Figure 44 Selecting ‘A WMS OGC Web Service’ 
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Paste the WMS URL into the box and click the ADD LAYER button (see Figure 45). 

 

 
Figure 45 Adding a WMS layer using a URL 

2.4 ArcGIS Earth 
ArcGIS Earth is an interactive 3D experience to plan, visualise and evaluate events on the 
globe. ArcGIS Earth provides situational awareness on desktop and mobile devices for 
improved decision-making. Ingest data in different formats, including 3D models; Keyhole 
Markup Language (KML), KML zipped (KMZ) files; TXT; and open services from ArcGIS or 
with a URL, to explore areas of interest in 3D. Manipulate KML in its entirety to understand 
changing circumstances. ArcGIS Earth is a free and easy-to-use tool to quickly fuse, 
manipulate and collaborate with 3D data. 
Select the ArcGIS Earth option from the ArcGIS REST Service page (Figure 46). 

 
Figure 46 ArcGIS Earth link to download KMZ file for ArcGIS Earth application 
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A message appears like the one shown in Figure 47. Open with the default (ArcGIS Earth). 
You can also save to file then open within ArcGIS Earth. 

 
Figure 47 Saving a KMZ file to your local drive 

In ArcGIS Earth click on the ‘+’ symbol to add the downloaded KMZ file as shown in 
Figure 48. 

 
Figure 48 Adding a layer in ArcGIS Earth 

Click on the hamburger button at the left of the panel and you can see a Data and Legend 
panel as shown in Figure 49. 

 
Figure 49 Accessing the ‘Data’ and ‘Legend’ panel 

You can now zoom in-out, pan and analyse map or add your mark ups using the tools 
available in the application. 
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2.5 Google Earth 
Google Earth Pro on desktop is free for users and has advanced features. Import and export 
GIS data, and go back in time with historical imagery. It is available on PC, Mac or Linux. 
Note that Google Earth Pro uses data services formatted in KML\KMZ, and there are 
limitations with KML layers (see ‘KML’ webpage for further information. 
Open Google Earth Pro on your system and select ‘Open’ from the File menu (Figure 50).  

 
Figure 50 Opening a saved file in Google Earth Pro 

Navigate to the KMZ file downloaded in previous step and open it (see Figure 47). The layer 
(VIS_SVTM_NSW_Extant_PCT.kmz in this example) is now added to Google Earth Pro 
(Figure 51).  

 
Figure 51 SVTM_NSW_Extant_PCT layer in Google Earth Pro 
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Use View on the menu bar to turn display options on or off. Use the zoom slider bar to zoom 
in so that the other data layers appear. Note that Google Earth may not show vector data if 
the data are too complex. 
There are not many tools in Google Earth for querying data – for much richer query 
functionality use SEED view or add WMS into your GIS system. 

2.6 ArcMap 
The ArcMap option will allow a user to open ArcMap (if installed) and display the WMS. 
Choose the ArcMap option from ArcGIS REST Services (see Figure 52). 

 
Figure 52 Choosing the ‘ArcMap’ option from ArcGIS REST Services 

If you select Open from the window shown in Figure 53, ArcMap should open with the WMS 
map layer, depending on the program associated with the file type (you may need to set the 
file type via Control Panel). Alternatively, you may save the layer file and add to an ArcMap 
session. 

 
Figure 53 Opening or saving a map in ArcMap 
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In ArcMap, the WMS should appear in the Table of Contents (TOC). If there is a broken 
link, you will need to manually add the WMS as described later in this section. 
Click on the plus symbol in the TOC to reveal the layers that comprise the layer file (see 
Figure 54). 

 
Figure 54 WMS showing in the ‘Table of Contents’ 

Instead of using the zoom button to view layers, you can right-click on a layer of interest and 
zoom directly to that layer, as shown in Figure 55. 

 
Figure 55 Zooming to a layer in a WMS 
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The ArcMap Identify tool can be used to click on a point within a layer to reveal the 
attributes for that location. The attributes may be for a polygon or a raster cell (as shown in 
Figure 56). 

 
Figure 56 Using the ‘Identify’ tool in ArcMap 

Alternatively, you may add the WMS service to an ArcMap session. 
As shown previously in Section 2.3, copy the WMS URL from ArcGIS REST Services (see 
Figure 57 to Figure 61). 

 
Figure 57 Connecting to WMS from the ArcGIS REST Services Directory 
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Go to Catalog and navigate to GIS Servers, then double-click Add WMS Server (see 
Figure 58). 

 
Figure 58 Adding a WMS in ArcMap 
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The Add WMS Server form opens. Paste the WMS URL into the box and remove any POST 
requests (i.e. all text after ‘/WMSServer?’ – see the highlighted text in Figure 59). The URL 
should follow the syntax in the example on the form. Refer to the ‘POST Method’ webpage 
for further information about POST requests. 
Click on the Get Layers button. 

 
Figure 59 Removing a POST request from the WMS URL 
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The layers that comprise the WMS are listed (see Figure 60). Note the information shown for 
each layer as selected, such as the display scale. Click OK. 

 
Figure 60 Layers showing for a WMS and clicking the ‘OK’ button 



How to use BioNet Web Map Services: A Quick Guide 

32 

The WMS and its layers now appear under GIS Servers (see Figure 61). 

 
Figure 61 GIS Servers showing WMS layers 

In ArcMap, select the Catalog button (see Figure 62). 

 
Figure 62 Selecting the ‘Catalog’ button 

Now click on GIS Servers > double click on WMS on mapprod3.environment.nsw.gov.au, 
and expand connections (Figure 63 and Figure 64). 

 
Figure 63 Expanded ‘GIS servers’ connections 
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Figure 64 Expanded WMS and Layers 

Drag layers from the Catalog into your ArcMap session (Figure 65). 

 
Figure 65 WMS layers in your ArcMap Session 

Click and expand WMS and you will see layers listed. Right-click on each layer and select 
Zoom To Make Visible (Figure 66). You will now see the data displayed. 

 
Figure 66 Zooming to visible scale 
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In line with this example, the WMS for the NSW Vegetation Formation, Class and PCT 
datasets are listed in the TOC and the map should look like Figure 67. 

 
Figure 67 Example of an initial display of WMS features 

Note that the visible scale of each dataset is different – as you zoom in or out, the relevant 
dataset will be turned on or off based on the zoom scale (Figure 68 to Figure 72). 

 
Figure 68 Example of ‘NSW_VegetationClass_5m’ layer display of WMS features 
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Figure 69 Example of ‘NSW_PlantCommunityType_5m’ layer display of WMS features 

 
Figure 70 Example of ‘Plant Community Type with labels’ layer display of WMS features 
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Figure 71 Example of ‘Plant Community Type with object labels’ layer display of WMS features 

 
Figure 72 Example of ‘Plant Community Type with object labels’ layer query result 
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2.7 ArcGIS Pro 
ArcGIS Pro is a free viewer previously available from the ESRI website. If you have this 
legacy viewer installed, you can select the ArcGIS Explorer option from the ArcGIS REST 
Services page. You can then open the application to display the WMS, or save to file (see 
Figure 73). 
If there is a broken link, you will need to manually add the WMS as described later in this 
section. 

 
Figure 73 Saving an ArcGIS Pro project file to your system 

Double-click on the above saved file from file explorer and it will open up in your ArcGIS Pro 
if you have installed the software in your system. 
Tick the checkbox to turn on the layer (Figure 74) and the map display will appear. 

 
Figure 74 ArcGIS Pro ‘Contents’ panel showing the SVTM_NSW_Extant_PCT data added for 

display 
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Now you can zoom in to your area of interest, and as you zoom in, each of the above listed 
layers will turn on depending on the zoom scale. You will see the rest of the layers ticked but 
greyed out, which means they are out of zoom level (Figure 75). 

 
Figure 75 Display zoomed in to features, showing ‘Plant Community Type with Object labels’ 

2.8 QGIS 
QGIS is a free and open source GIS. It is effective to use with both WMS and WFS. 
After opening QGIS, it is recommended you first add a WMS, then zoom in to a smaller 
geographical area, before adding the WFS layer. This should restrict the volume of data 
served over the internet. 
The WMS URL can be copied by clicking on WMS at the top of the ArcGIS REST Services 
Directory window, then copying the web address from the new window (see Figure 76). 

 
Figure 76 Connecting to WMS from the ArcGIS REST Services Directory 
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Open the QGIS software and in the Browser panel, click on the Add WMS/WMTS Layer 
icon (see Figure 77). 

 
Figure 77 QGIS table of content ‘Browser’ panel 

Right click on WMS/WMTS and select New Connection as shown in Figure 78. 

 
Figure 78 Adding a WMS 
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A new form opens. Enter a name for the WMS connection, then copy and paste the URL. 
Click OK (see Figure 79). 

 
Figure 79 Entering a name and URL for the new WMS connection 

 
Figure 80 WMS service is successfully connected and layers are listed under WMS/WMTS 
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Figure 81 ‘Add Layer to Project’ 

Right-click on each of the layers and select Add Layer to Project to add it. Alternatively, 
left-click multiple layers while holding down the shift key to select them. 
The layer at the top of the Layers panel (or TOC) will display first, in this case, vegetation 
formations (see Figure 82 and Figure 83). 

 
Figure 82 ‘Layers’ panel showing WMS layers 

 
Figure 83 Map showing vegetation formations 
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Adjust the zoom scale according to the ranges in Table 2 as needed to visualise the data. 
Note that Plant Community Type with labels and Plant Community Type with object 
labels are the lowest level information. 

Table 2 Layer names and scale range 

Layer name Scale range 

NSW_VegetationFormation_5m  1:1,000,000 to <None> 

NSW_VegetationClass_5m 1:100,000 to 1:1,000,000 

NSW_PlantCommunity Type_5m 1:20,000 to 1:100,000 

Plant Community Type with labels  1:20,000 to 1:2,500 

Plant Community Type with Object labels  <None> to 1:2,499 

The display should resemble the one in Figure 84. 

 
Figure 84 PCTID with OBJECTID labels 

The WMS feature can be used in GIS analysis; for example, you may use the Identify 
Features tool to click on the display to reveal the attributes at that location (see Figure 85). 

 
Figure 85 Selecting the ‘Identify Features’ tool 
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Figure 86 shows the attributes for a polygon after clicking on an area on the map. 

 
Figure 86 Attributes for a polygon of a WMS layer 

The above is only a subset of GIS tasks that can be performed. For more information, please 
refer to the ‘QGIS Tutorials and Tips’ webpage. 
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Glossary 
ArcGIS REST Service – REST is the acronym for Representational State Transfer, which is 
an architecture for sharing information through the use of simple HTTP protocols. ArcGIS is 
a geographic information system (GIS) software package. 
Keyhole Markup Language (KML) – a file format for the display of geographical data in 
browsers such as Google Earth. 
Open Geospatial Compliant (OGC) web services – web services that are compliant with 
OGC standards. Software developers use these standards for their products and services. 
Quickview maps – simplified versions of the vegetation maps that only contain a subset of 
the attributes available. They are easier to navigate than the more detailed vegetation maps. 
They cover the entire region, whereas the vegetation maps are supplied as 1:100,000 map 
sheets. 
Web Feature Service (WFS) – a protocol for serving geographical features over the web. 
This includes feature geometry and attributes. 
Web Map Service (WMS) – a simple HTTP interface for serving geo-registered map images 
from a geospatial database. 

More information 
• ArcGIS Online Map Viewer 
• ArcGIS JavaScript 
• ArcGIS Explorer Desktop legacy viewer 
• ArcGIS REST Services 
• ArcMap 
• Enable JavaScript 
• Finding data in SEED 
• How do I use SEED? 
• KML 
• Open Geospatial Consortium Web Map Service 
• POST Method 
• QGIS 
• QGIS Tutorials and Tips 
• SEED (Sharing and Enabling Environmental Data) 
• SEED dataset search 
• SVTM_NSW_Extant WMS 
• SVT_NSW_1750 WMS 

https://www.arcgis.com/home/webmap/viewer.html?url=https%3A%2F%2Fmapprod3.environment.nsw.gov.au%2Farcgis%2Frest%2Fservices%2FVIS%2FSVTM_NSW_Extant_PCT%2FMapServer&source=sd
https://www.arcgis.com/home/webmap/viewer.html?url=https%3A%2F%2Fmapprod3.environment.nsw.gov.au%2Farcgis%2Frest%2Fservices%2FVIS%2FSVTM_NSW_Extant_PCT%2FMapServer&source=sd
https://mapprod3.environment.nsw.gov.au/arcgis/rest/services/VIS/SVTM_NSW_Extant_PCT/MapServer?f=jsapi
https://community.esri.com/t5/arcgis-explorer-desktop-blog/arcgis-explorer-desktop-retired-10-1-2017/ba-p/883791
https://mapprod3.environment.nsw.gov.au/arcgis/rest/services/VIS/SVTM_NSW_Extant_PCT/MapServer
https://mapprod3.environment.nsw.gov.au/arcgis/rest/services/VIS/SVTM_NSW_Extant_PCT/MapServer?f=lyr&v=9.3
https://www.whatismybrowser.com/guides/how-to-enable-javascript/
https://www.seed.nsw.gov.au/need-help/finding-data-on-dataset-catalogue/finding-data-seed
https://www.seed.nsw.gov.au/need-help
https://doc.arcgis.com/en/arcgis-online/reference/kml.htm
https://www.ogc.org/STANDARDS/WMS
https://www.jmarshall.com/easy/http/#postmethod
http://www.qgis.org/en/site/
http://www.qgistutorials.com/en/index.html
https://www.seed.nsw.gov.au/
https://datasets.seed.nsw.gov.au/dataset/
https://mapuat3.environment.nsw.gov.au/arcgis/rest/services/VIS/SVTM_NSW_Extant_PCT/MapServer
https://mapuat3.environment.nsw.gov.au/arcgis/rest/services/VIS/SVTM_NSW_1750_PCT/MapServer
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